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Technical Support Contact Information 

 

Clinic Team Members 

If you are experiencing difficulties using the AIM Monthly Report Form it is highly recommended that 
you consult the table of contents of this document and your Facilitator for support before contacting the 
AIM Measurement Support Team at: 

 

measurement@albertaaim.ca 

 

Facilitators and Faculty Members 

Facilitators and Faculty members should consult the table of contents of this document for support 
before contacting the AIM Measurement Support Team at: 

 

measurement@albertaaim.ca 

mailto:measurement@albertaaim.ca
mailto:measurement@albertaaim.ca
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Getting Started 

Considerations for Installing the Monthly Report Form 

The following are important installation considerations:  

Your Microsoft Office Word Application – is it local or remote? 

To use the Monthly Report Form your team will need access to Microsoft Office Word.  For the 
document to function optimally it is best to use a version of Microsoft Office Word that is located locally 
on your computer.   

If your clinic accesses applications like Microsoft Office Word remotely through a server (e.g. Citrix, 
ASP, VBI, Thin Client etc…) you should be aware that certain functional components in the form may 
run quite slow.  Additionally, changing your security settings may prove difficult. 

If you are unsure about the type of Microsoft Office Word setup your clinic has or know it’s accessed 
remotely please contact the AIM Measurement Support Team at measurement@albertaaim.ca 

Which version of the Monthly Report Form should we use? 

There are 2 versions of the Monthly Report Form available.  You will only need to use one.   

 If your clinic identifies itself as Primary use the “Monthly Report Form – PRIMARY.doc”. 

 If your clinic/program identifies itself as Specialty use the “Monthly Report Form – 
SPECIALTY.doc”. 

If you are unclear about which of the categories your clinic/program fits into speak to your Facilitator for 
clarification. 

Where should we save the file? 

Similar to the all the AIM Tools and Resources, it is recommended that users save the Monthly Report 
Form on their C:\drive (i.e. local drive) in a folder named “AIM”.   

How to determine what version of Microsoft Office Word your clinic is using 

Why is this important?  Throughout this User Guide you’ll note some sections have different sets of 
instructions that vary by version of Microsoft Office Word (e.g. how you will change your security 
settings such that the form can operate properly).  

mailto:measurement@albertaaim.ca
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Word 1997 to 2003 Users - Under the Help menu, select “About Microsoft Office Word”.  The window 
that appears will display which edition of Microsoft Office Word is loaded on the computer you are 
using.  

Word 2007 (and newer) Users - Click the Microsoft Office button   the Word Options button  
the Resources option.  At the bottom of the list that appears on the right hand side of the window the 
version of Word should be noted.  If the version is not indicated here - click the About button to 
determine which Word version you have on your computer. 

Initial Setup – Changing Your Security Settings 

Similar to the Excel Tools (i.e. AIMTracking and AIMAnalysis files), once installation is complete you 
must first change the security setting in Microsoft Word for the Monthly Report Form to function 
properly.  

If you are using the form on more than one computer station please note you will need to change the 
security settings on each station being used. 

NOTE: the steps necessary to complete the security settings change vary by version of Microsoft Office 
Word.  Please use the set of instructions below that apply to your version of Word.  If you do not know 
which version your clinic is using, please refer to the “How to determine what version of Microsoft Office 
Word your clinic is using” section above for help. 

Microsoft Office – Word 1997 to 2003 Users 

If you receive the following pop-up message while using the file, the security settings in your Microsoft 
Office Word need to be changed.  They should be set to “Medium”.   

 

To check on your settings, or to change them, follow these steps: 

1. Open your Monthly Report Form file 

2. Under the Tools menu, click Options 

3. Click the Security tab 
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4. Under Macro Security, click Macro Security 

5. Click the Security Level tab, and then select the security level you want to use.  (Choose 
Medium) 

6. Close the file (save your changes) 

7. Reopen your Monthly Report Form file and the new security level should be in effect 

NOTE: once you change your security settings, they are changed for Microsoft Office Word, not just for 
the Monthly Report Form.  They will stay on “Medium” until set to another level.  

Taking the steps above will cause Microsoft Office Word to present you with the Security Warning 
message (below) each time you open your Monthly Report Form.  Always click Enable Macros for the 
AIM Monthly Report Form.  For any other file (i.e. non AIM files) from an unknown or untrusted source, 
click Disable Macros. 

 

Microsoft Office – Word 2007 (and newer) Users 

Unlike older versions of Microsoft Office Word, those using Word 2007 will need to create a Trusted 
Location in order for the Monthly Report Form to function properly. 

What is a Trusted Location?   A trusted location is typically a folder on your hard drive (C:\ drive) or a 
network share. Any file placed in a trusted location can be opened and will be allowed to run without 
being checked by the Trust Center security system. As the Monthly Report Form comes from a trusted 
source, allowing it to run without a security scan is safe. 

If you see the following Security Warning message below the Ribbons when you open your Monthly 
Report Form this message means a Trusted Location needs to be created for the file. 
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To create your Trusted Location follow these steps: 

1. Open your Monthly Report Form file 

2. Click the Microsoft Office Button  , and then click Word Options 

3. Click Trust Center and then Trust Center Settings 

4. Click Trusted Locations 

5. If you want to create a Trusted Location that is not local to your computer (i.e. not on your C:\ 
drive), select the Allow trusted locations on my network (not recommended) check box 

6. Click Add new location 

7. In the Path box, type the name of the folder that you want to use as a Trusted Location, or click 
Browse to locate the folder (e.g. the AIM folder you installed onto your C:\ drive) 

8. If you want to include subfolders as trusted locations, select the Subfolders of this location are 
also trusted check box 

9. In the Description box, type what you want to describe the purpose of the trusted location 
(OPTIONAL) 

10. Click OK (three times) 

11. Save the file.  Close and reopen it.  You should no longer receive the “Security Warning – 
Macros Have Been Disabled” prompt 

Important Consideration When Creating Your Trusted Location - we strongly recommend that you do 
NOT make a location common to all computers (e.g. your entire C:\ drive, your Desktop or your My 
Documents folder) a Trusted Location.  Doing so will put you at a security risk (e.g. make you 
vulnerable to viruses). 



8 

 

Exploring the Monthly Report Form 

Purpose 

The purpose of the Monthly Report Form is to capture a written account of each team’s improvement 
journey.   

In a diary or journal style format teams identify their aims and communicate their progress (i.e. 
changes/activities) to their Faculty member who then provides feedback. 

Key Features 

The Monthly Report Form is designed to be user friendly.  Key features include: 

 A Table of Contents which can be updated as the document grows such that specific 
content can be located or referenced quickly and accurately. 

 Designated fields where information can be recorded.  If it’s gray you can type in it!!  
This feature helps users discern where they should be recording information and prevents 
the deletion of valuable information which is intended to be permanent. 

 Customized help (press F1) to guide the user in the event he/she is unclear on what type of 
information should be recorded in a specific field. 

 A spell and grammar check option. 

 The ability to ADD and HIDE specific sections as desired.  This feature helps to keep the 
document as succinct and relevant as possible based on the user’s preference. 

o As the form grows you can “add” and “hide” entire reporting period sections (e.g. 
Team Report and Faculty Feedback for reports 1 through 7) 

o Throughout the form there are standardized Access/Office Efficiency or Clinical Care 
Feedback sections that are locked.  Over time you may choose to “hide” or “add” this 
information within your form. 

Please refer to the “The Control Panel – Report Dates and Document Structure 
Section” section below for instructions on how to use the “add” and “hide” features. 



9 

 

Section Descriptions 

The Monthly Report Form is comprised of the following sections: 

Section What Information Should Be Recorded Here? 

Instructions for Use: No information can be recorded in this section.  It provides a brief description of the 
information required for each of the main document sections and a set of instructions 
outlining how to operate the key features of the document.  

Demographics: A designated area for your team to provide information about your clinic/program.  The 
Faculty Feedback area allows your Faculty member to provide comments or questions 
specific to your description. 

Report Dates and 
Document Structure: 

An area to record the Month-Year and assigned Faculty for each reporting period. 

This is also the control panel of the form.  Here you can: 

  “add” or “hide” entire Team Report and Faculty Feedback sections 
throughout the form associated with each reporting period   

 “add” or “hide” standardized Access/Office Efficiency or Clinical Care 
Feedback sections 

 update the Table of Contents 

 run a spell and grammar check 

Measures: An area to record information specific to the measures your team will be collecting – 
i.e. when and how is the data collected and who is responsible for the collection 

The Measures Report and Feedback section has designated areas for Teams and 
Faculty to provide comments and feedback per reporting period which are specific to 
the measures. 

Note: users have the capability to “add” and “hide” entire reporting period Team Report 
and Faculty Feedback sections - please refer to the Using the Monthly Report Form - 
The Control Panel – Report Dates and Document Structure Section below for 
instructions on how to “add” and “hide” content. 

Access: A section designated to Access improvements divided into 6 key areas of focus.  
Teams record their Access aim here and use the designated Team Report areas to 
communicate their ongoing Access improvement journey to which Faculty can provide 
feedback to per reporting period.   
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Each of the 6 key areas of focus have: 

 standardized feedback which can be “added” or “hidden” by the user  

 designated Team Report and Faculty Feedback sections per reporting 
period which can also be “added” or “hidden” by the user 

NOTE: please refer to the Using the Monthly Report Form - The Control 
Panel – Report Dates and Document Structure Section below for 
instructions on how to “add” and “hide” content. 

Office Efficiency: A section designated to Office Efficiency improvements divided into 5 key areas of 
focus.  Teams record their Office Efficiency aim here and use the designated Team 
Report areas to communicate their ongoing Office Efficiency improvement journey to 
which Faculty can provide feedback to per reporting period.   

Each of the 5 key areas of focus have: 

 standardized feedback which can be “added” or “hidden” by the user 

 designated Team Report and Faculty Feedback sections per reporting 
period which can also be “added” or “hidden” by the user 

NOTE: please refer to the Using the Monthly Report Form - The Control 
Panel – Report Dates and Document Structure Section below for 
instructions on how to “add” and “hide” content. 

Clinical Care:  

NOTE: Please leave the 
Clinical Care section 
blank until you move 

into making clinical 
care changes/ 

improvements or until 
directed by your 

Facilitator/ Faculty to 
do so. 

A section designated to Clinical Care improvements divided into 6 key areas of focus.  
Teams record their Clinical Care aim here and use the designated Team Report areas 
to communicate their ongoing Clinical Care improvement journey to which Faculty can 
provide feedback to per reporting period.   

Each of the 6 key areas of focus have: 

 standardized feedback which can be “added” or “hidden” by the user 

 designated Team Report and Faculty Feedback sections per reporting 
period which can also be “added” or “hidden” by the user 

NOTE: please refer to the Using the Monthly Report Form - The Control 
Panel – Report Dates and Document Structure Section below for 
instructions on how to “add” and “hide” content. 

Overall Comments: An area available for additional information to describe your clinic, your activities and 
improvements. 

Similar to the above sections, the comments section has designated areas for Team 
Reports and Faculty Feedback per reporting period. 

Note: users have the capability to “add” and “hide” entire reporting period Team Report 
and Faculty Feedback sections - please refer to the Using the Monthly Report Form - 
The Control Panel – Report Dates and Document Structure Section below for 
instructions on how to “add” and “hide” content. 
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Using the Monthly Report Form 

Security Prompt – Each Time You Open the File 

Please refer to the “Getting Started - Initial Setup – Changing Your Security Settings” section above if 
you have not already changed/checked your Microsoft Office Word security settings. 

Please recall, if you are using the form on more than one computer station you will need to 
change/check the security setting on each station being used. 

Once the security settings have been changed initially, please note the security prompt (below) you will 
be given each time you open this file will vary by version of Microsoft Office. 

Microsoft Office – Word 1997 to 2003 Users 

Word 1997 to 2003 users will receive the following message each time the form is opened: 

 

For the form to function properly, always click Enable Macros for the AIM Monthly Report Form.  For 
any other file (i.e. non AIM files) from an unknown or untrusted source, click Disable Macros. 

Microsoft Office – Word 2007 (and newer) Users 

If the Trusted Location has been setup Word 2007 and newer users will not receive a security prompt. 

If the form has not been saved to a designated Trusted Location the following security warning 
message will be displayed.  To setup a Trusted Location please refer to the “Initial Setup – Changing 
Your Security Settings – Microsoft Office – Word 2007 (and newer) Users” section above for 
instructions. 
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The Control Panel – Report Dates and Document Structure Section 

As the form grows you may choose to add and hide certain sections of the report.  In addition to being 
able to specify the Month-Year and assigned Faculty for each reporting period, the ability to update the 
Table of Contents and to run a spelling/grammar check on the text entered, the “Report Dates and 
Document Structure” section allows you to add and hide various sections. 

It’s important to note that adding or hiding an entire Report Date (e.g. 1st Report Date) will impact all the 
associated Team Report and Faculty Feedback sections throughout the entire form.  For example, 
hiding the 1st Report Date will hide all the Team Report 1 and Faculty Feedback 1 sections throughout 
the form. 
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How to use the “Add” and “Hide” Functions 

To add or hide Team Reports and Faculty Feedback for a specific reporting period throughout the form 
or standardized Access/Office Efficiency or Clinical Care Feedback sections: 

1. Check the box of interest 

2. Press the Tab key 

** Whenever you’ve added or hidden sections it’s a good idea to update the Table of Contents 
(refer to the “Updating the Table of Contents” section below for instructions) 

 

In the example below the 1st, 2nd and 3rd reports have been “Added” while the rest of the reports have 
been “Hidden”. 
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Designated Fields for Recording Information 

Essentially, if it's gray you can type in it!!!!! 

With the exception of the “Instructions for Use” section, the remaining sections of the form can all be 
customized. 

Please refer to the “Exploring the Monthly Report Form – Section Descriptions” section above for more 
in depth descriptions on what should be recorded in each of the sections.  Alternatively, use the Help 
function (see the “Help Function (press F1)” section below for instructions) to discern what information 
is required in each of the gray fields. 

Documenting Your Improvement Journey and Communicating with Faculty 

Take a moment to scroll through the Monthly Report Form.  Where ever you see the following Team 
Report and Faculty Feedback sections (i.e. under the Measures, Access, Office Efficiency, Clinical 
Care and Overall Comments sections), these are the areas your team can communicate with your 
Faculty member about your improvement journey (e.g. changes/activities). 

As you will be required to submit 7 reports, there are 7 paired areas for Teams and Faculty members to 
communicate.  Please ensure you’re using the appropriate section per reporting period.    
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You’ll note some sections have more Team Report and Faculty Feedback sections than others (i.e. 
Access and Office Efficiency).  As each team’s focus will be different some sections with Team Report 
and Faculty Feedback sections may not be applicable to you.  Please only report on the sections your 
team is actively working on. 

Help Function (press F1) 

To aid you in the use of the document most gray boxes have customized help messages that will 
provide guidance on what type of information is required. 

To use this function there are 2 options. 

Option 1 

1. Click inside the gray box of interest  

2. Press F1 

For example: 

 

Option 2 

1. Click inside the gray box of interest  
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2. Look at the Status Bar in the bottom left hand corner of the screen to view the help message 

 

Updating the Table of Contents 

As the form grows or particular sections are “added” or “hidden” it’s recommended that you get into the 
habit of updating the table of contents.  

To do this take the following steps: 

1. Go to the Report Dates and Document Structure section of the form 

2. Click in the “Update Table of Contents” checkbox such that an X appears in it 

3. Press the Tab key 

 

Navigating the Form 

As the form grows or shrinks there are a few options available that will allow you to navigate accurately 
and quickly to specific sections of interest. 

Part 1: Update the Table of Contents 

Refer to the “Updating the Table of Contents” section above for instructions. 
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Part 2: Shortcuts for Navigating to a Section of Interest  

Once the Table of Contents is updated there are a few options to navigate quickly to various sections of 
interest in the form.  These options vary by version of Microsoft Office Word being used. 

Microsoft Office – Word 1997 to 2003 Users 

Word 1997 to 2003 users have 2 options for quick navigation: 

Option 1 

1. Note the page number of interest in the updated Table of Contents 

2. Press F5 

3. In the window that appears: 

a. ensure “Page” is selected under “Go to what:” 

b. enter the page number of interest 

c. click the Go To button 
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Option 2 

1. Under the View menu select Document Map 

 

2. Select the section of interest from the list that appears on the left hand side of the screen 
(NOTE: the + and – signs that allow you to expand and collapse sections of interest) 
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Microsoft Office – Word 2007 (and newer) Users 

Word 2007 and newer users have 3 options for quick navigation: 

 

Option 1 

See Option 1 for Word 1997 to 2003 users above. 

 

Option 2 

1. In the Table of Contents section, hold your cursor over the section of interest 

2. Hold down the CTRL key and click the mouse over the section of interest 
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Option 3 

1. Under the View Ribbon select Document Map 

2. Select the section of interest from the list that appears on the left hand side of the screen 
(NOTE: the + and – signs that allow you to expand and collapse sections of interest) 
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Performing a Spell and Grammar Check 

You may want to run a spell and grammar check on newly added text.  Unlike normal word documents 
a spell and grammar check isn’t done automatically in this form.  To carry out this function: 

1. Go to the Report Dates and Document Structure section of the form 

2.  Check the “Run Spell and Grammar Check” checkbox 

 

3. Press the Tab key 

4. The 2 checks will be run separate of one another – i.e. once the spell check is complete the 
following message will appear: 

 

5. Select “yes” and the grammar check will start from the beginning of the form. 

 

NOTE: hidden text will not be checked. 


